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1 . Пространственное моделирование. Общие сведения
AutoCAD позволяет создавать три типа пространственных моделей.
Каркасная модель представляет собой скелетное описание ЗМ-объекта. Она не 

имеет граней и состоит только из точек, отрезков и кривых, описывающих рёбра 
объекта. AutoCAD предоставляет возможность создавать каркасные модели путем 
размещения плоских объектов в любом месте пространства. Кроме того, AutoCAD 
позволяет непосредственно строить некоторые виды трёхмерных объектов типа кар­
касных моделей: например, ЗМ-полилинии и сплайны. Поскольку каждый из состав­
ляющих такую модель объектов должен рисоваться и размещаться независимо от 
других, затраты времени на моделирование часто бывают крайне велики.

Поверхности. Моделирование с помощью поверхностей является более слож­
ным процессом, так как здесь описываются не только рёбра ЗМ-объекта, но и его 
грани. AutoCAD строит поверхности на базе многоугольных сетей. Так как грани сети 
являются плоскими, представление криволинейных поверхностей производится пу­
тем их аппроксимации.

Твердотельные модели. Моделирование с помощью тел -  это самый простой в 
использовании вид ЗМ-моделирования. Средства AutoCAD по моделированию тел 
позволяют создавать трёхмерные объекты на основе базовых пространственных 
форм: параллелепипедов, конусов, цилиндров, сфер, клинов и торов. Из этих форм 
путем их объединения, вычитания и пересечения строятся более сложные про­
странственные тела. Кроме того, тела можно строить, сдвигая 2М-объект вдоль за­
данного вектора или вращая его вокруг оси.

2. Просмотр трёхмерных объектов
Находясь в пространстве модели, можно рассматривать рисунок AutoCAD с лю­

бой точки. Поместив точку зрения в заданную позицию, можно создавать новые объ­
екты, редактировать существующие, а также генерировать изображения с подавлен­
ными скрытыми линиями, раскрашенные и тонированные изображения. Кроме того, 
имеется возможность создавать виды в ортогональной и перспективной проекциях.

Для просмотра трёхмерных объектов удобно пользоваться панелью View или 
пунктами меню

View -*■ 3D Views: 
Ортогональные виды:

а
ш

Тор
Bottom

ж Left
ш Right
в Front
я Back
Изометрические виды:
ф SW Isometric

SE Isometric
А NE Isometric
ф NW Isometric

Для просмотра трёхмерного объекта под произвольным углом выделите его и вы­
полните View -* 3D Orbit. В режиме 3D Orbit вокруг изображения появляется коор­
динатный шар (arcball) или орбита -  большой круг с малыми кругами в квадрантах.
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В разных областях орбиты указатель принимает различные виды и, соответственно, 
по-разному вращает модель (рис. 2.1):

Ф  Sphere and lines -  внутри орбиты, вращение во всех направлениях;

-0- Vertical ellipse -  в верхнем и нижнем квадрантах, вращение вокруг горизон­
тальной оси;

И-'-''

0 Circular arrow -  за пределами орбиты, вращение в плоскости экрана.
Рисунок 2.1
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Рисунок 2.2
Чтобы организовать непрерывное вращение объекта в режиме 3D Orbit, в контекст­

ном меню выберите More -» Continuous Orbit, а затем мышью задайте направление 
вращения. Остановить вращение можно командой Orbit контекстного меню (рис. 2.2).

Для использования настроенного вида в дальнейшем ему необходимо дать имя. 
Для этого выполните View -*• Named Views (рис. 2.3), щёлкните дважды по имени 
вида Current и введите свое название вида. В дальнейшем в этом окне можно двой­
ным щелчком мыши выбирать какой-либо из ранее сохранённых видов.

Рисунок 2.3
Для просмотра только видимых граней трёхмерного объекта выполните View -*• 

Hide.
На трёхмерный объект можно наложить тонировку. Для этого выполните View -* 

Shade -» Flat Shade для объектов, состоящих из плоскостей или View -» Shade -» 
Gouraud Shade для скругленных объектов. Команда View — Shade -> Hidden рабо­
тает так же, как и команда Hide, но сохраняет своё действие при изменении угла 
просмотра и во время редактирования. Для возврата к каркасному виду выполните 
View -> Shade -» 2D Wireframe.
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3. Каркасные модели
Каркасы (wireframe) -  это объекты, помещённые в трёхмерное пространство, ко­
торые состоят из точек, линий и трёхмерных полилиний. Они не имеют поверхно­
стей и объёма.
Для создания каркасов используются следующие способы:
• Для построения фигуры, параллельной текущей плоскости и находящейся на 
некоторой высоте над ней, при вводе координат первой точки задайте и третью 
координату, указывающую её высоту.
• Для построения фигуры, плоскость которой непараллельна текущей, используй­
те пользовательские системы координат или воспользуйтесь инструментом 3D 
Polyline.
• Для построения фигуры, вершины которой не принадлежат одной плоскости, ис­
пользуйте инструмент 3D Polyline.
С целью получения полноценной пространственной модели на созданный каркас 
(проволочную модель) можно натянуть поверхности, выполнив Draw -» Surfaces -» 
3D Face .

4. Поверхности
При моделировании пространственных объектов с помощью поверхностей созда­

ются не только рёбра, но и грани объектов. Сами поверхности, в свою очередь, ап­
проксимируются плоскими мозаичными кусочками, образуя структуру, называемую 
сетью.

При работе с поверхностями удобно пользоваться панелью Surfaces (рис. 4.1):

Surfaces 2SJ

4 4  ® ^ А А @ © © @  О Ъ

Рисунок 4.1
В AutoCAD имеется несколько способов построения сетей:
Построение стандартной трёхмерной сети. В AutoCAD можно создавать трёх­

мерные сети в форме параллелепипедов, конусов, чаш, куполов, решеток, пирамид, 
сфер, торов и клинов. Для создания такой сети выполните Draw -» Surfaces -*■ 3D 
Surfaces. В окне 3D Objects (рис. 4.2) выберите поверхность и нажмите кнопку ОК.

Рисунок 4.2
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• iS j Box. Для построения достаточно указать координаты одной вершины, а за­
тем длину, ширину и высоту.

• ЛЁ] Pyramid. Укажите координаты трёх вершин основания пирамиды, затем если 
вы хотите создать тетраэдр, то введите в командную строку Т, нажмите Enter и вво­
дите координату вершины. А если хотите построить пирамиду с четырёхугольным 
основанием, то вводите координату четвертого угла основания, а затем вводите ко­
ординату вершины пирамиды.

• Sphere. Указываются координаты центра сферы, её радиус, затем количест­
во сегментов, из которых будет состоять поверхность сферы в продольном направ­
лении, а потом количество сегментов, из которых будет состоять поверхность сферы 
в поперечном направлении.

.  А] Cone. Введите координаты центра основания конуса, укажите его радиус, 
затем радиус второго основания (если равен нулю, получится обычный конус, если 
больше нуля, будет усеченный конус, а если радиусы оснований равны, получится 
цилиндр). Введите высоту конуса и количество сегментов, из которых будет строить­
ся поверхность конуса.

• Torus. Указываются координаты центра тора, радиус, радиус «трубы» тора 
(при этом радиус «трубы» тора должен быть не больше половины радиуса самого 
тора), количество сегментов, из которых будет состоять поверхность тора в про­
дольном направлении, а затем и в поперечном направлении.

Остальные поверхности строятся аналогично.
Построение сети в виде поверхности сдвига. Jh J Сети в виде поверхности 

сдвига, задаваемые определяющей кривой и направляющим вектором, строятся ко­
мандой Draw -» Surfaces -» Tabulated Surface. Определяющая кривая может пред­
ставлять собой отрезок, дугу, круг, эллипс, эллиптическую дугу, 2М- или ЗМ- 
полилинию, а также сплайн. Направляющий вектор может быть отрезком либо ра­
зомкнутой полилинией. Созданная сеть представляет собой набор многоугольников 
с параллельными направляющему вектору сторонами. И определяющая кривая, и 
направляющий вектор должны существовать на рисунке к моменту вызова команды.

Построение сети в виде поверхности вращения. Сеть в виде поверхности 
вращения, образующейся в результате вращения плоской фигуры (сечения трёх­
мерного объекта) вокруг некоторой оси, создаётся командой Draw -* Surfaces -* 
Revolved Surface. Данная команда применяется для получения поверхностей, обла­
дающих осевой симметрией.

Построение сети в виде поверхности, заданной кромками. Сеть в виде участка по­
верхности Кунса, определяемая четырьмя кромками, строится командой Draw -» 
Surfaces -* Edge Surface. Кромки могут представлять собой дуги, отрезки, полили­
нии, сплайны или эллиптические дуги; они должны попарно смыкаться в конечных 
точках. Участок поверхности Кунса -  это поверхность, натянутая на четыре про­
странственные кривые.

5. Трёхмерные тела
Твердотельный объект, или тело, представляет собой изображение объекта, хра­

нящее, помимо всего прочего, информацию о своих объёмных свойствах.
Команды создания трёхмерных тел находятся в меню Draw -» Solids или в пане­

ли Solids:
^ Box -  параллелепипед;

Sphere-шар;
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-У  Cylinder -  цилиндр;
Cone-конус;
Wedge -  клин;
Torus -  тор;
Exrtude -  создание выдавленного тела;
Revolve -  создание тела вращения;
Slice -  разрез;
Section -  сечение;
Interference -  взаимодействие.

Кроме стандартных тел, возможно создание тел вращения и выдавленных тел на 
основе замкнутой фигуры, области или контура.

Для создания тела вращения выполните Draw Solids - *  Revolve. Выберите 
фигуру, из которой будет создаваться тело вращения, затем укажите две точки на 
оси вращения, а после угол поворота.

От порядка указания точек на оси вращения зависит направление создания тела -  
его можно определить по следующему правилу: если взгляд направлен вдоль оси 
вращения так, что первая точка ближе, то тело будет создаваться по часовой стрелке.

Для создания выдавленного тела выполните Draw — Solids -* Extrude. Укажите 
фигуру, служащую основанием тела, затем введите в командную строку высоту бу­
дущего тела и угол сужения. При этом необходимо соотносить высоту тела и угол 
сужения, т.к. если угол слишком большой, а высота маленькая, то верхнее основа­
ние вырождается, и такое тело строиться не будет.

Также выдавливать тело можно с указанием траектории выдавливания. Для 
этого после указания основания тела выберите команду Path и укажите линию, кото­
рая будет служить траекторией.

Построенное тело можно разрезать. Для этого выполните Draw -> Solids -» 
Slice. Укажите тело, которое необходимо разрезать, затем координаты трех точек, 
определяющих плоскость разреза, и щелкните по той части тела, которую необхо­
димо оставить.

Для того, чтобы провести сечение тела, выполните Draw -» Solids -* Section. 
Укажите тело, в котором необходимо провести сечение, затем координаты трех то­
чек, определяющих плоскость сечения.

6. Логические операции

Операция объединения ® j Modify -> Solids Editing -* Union создаёт новое те­
ло на основе нескольких выбранных, состоящее из всех точек этих тел.

При вызове команды появится запрос Select object: -  выделите объединяемые те­
ла, для завершения выбора нажмите клавишу Enter.

Операция вычитания Modify -* Solids Editing -> Subtract создаёт тело, со­
держащее только те точки первой группы тел, которые не содержатся во второй 
группе тел.

При вызове команды на первый запрос Select solids and regions to subtract 
from...Select object: выделите первую группу тел, нажмите клавишу Enter. Затем на 
запрос Select solids and regions to subtract.. Select object: укажите вторую группу тел.

Операция пересечения’  ̂ Modify -»■ Solids Editing -* Intersect создаёт тело, 
состоящее из точек, принадлежавших одновременно всем выбранным телам.
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Операция создания тела взаимодействия Draw -* Solids -> Interference похо­
жа на операцию пересечения, но отличается от неё двумя моментами:

• при её применении создаётся новое тело, но старые тела не уничтожаются;
• эта операция применяется к двум группам тел, в отличие от операции пересе­

чения, которая применяется к двум или более одиночным телам.
Пояснить это можно на нескольких примерах (рис. 6.1, рис. 6.2). Зелёная область 

на рисунке получена пересечением всех трёх фигур:

Рисунок 6.1

На этом же рисунке зелёным цветом показана фигура, полученная как взаимодей­
ствие прямоугольника (первая группа) и двух кругов (вторая группа):

Рисунок 6.2

7. Редактирование ЗМ-объектов
Модели реальных объектов обычно формируются путём сочетания типовых тел, к 

которым применены операции объединения, пересечения, вычитания. Кроме этого, 
тела в пространстве можно поворачивать, размножать массивами, создавать зер­
кальные копии, снимать фаску, сопрягать грани, строить разрезы и сечения. К объ­
ёмным телам могут быть применены некоторые двумерные команды редактирова­
ния: Erase, Copy, Mirror (при условии, что ось лежит в плоскости XY, в противном 
случае используется команда Mirror3D), Array (строит массив только в плоскости 
XY, в противном случае необходимо использовать команду 3D Array), Move, Rotate 
(производит поворот в плоскости XY, в противном случае используется команда 
Rotate3D), Scale, Chamfer, Fillet, Align.

Рассмотрим специфические команды редактирования трёхмерных объектов. Они 
находятся в меню Modify -> 3D Operation и Modify -* Solid Editing и в панели Sol­
ids Editing (рис. 7.1).
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Рисунок 7.1
• 3D Array позволяет вычерчивать круговой и прямоугольный трёхмерные масси­

вы. При построении кругового массива необходимо предварительно создать не 
только размножаемые объекты, но и ось поворота. Выполните Modify -> 3D 
Operation 3D Array.

• Select objects: -  можно выбирать несколько объектов, завершаете выбор нажа­
тием Enter;

• Enter the type of array [Rectangular/Polar] <R>: (Задайте тип массива (Прямо- 
угольный/Круговой):) -  выберите соответствующую команду в контекстном меню;

• Если вы строите круговой массив:
• Enter the number of items in the array: - Задайте количество элементов массива;
• Specify the angle to fill (+=ccw, -=cw) <360: - Укажите угол заполнения (+ по ча­

совой стрелке, -  против);
• Rotate arrayed objects? [Yes/No] <Y>: - Поворачивать объекты? Ща/Нет];
• Specify center point of array: -Укажите точку на оси;
• Specify second point on axis of rotation: -Укажите вторую точку на оси.
• Если вы строите прямоугольный массив:
• Enter the number of rows (—) <1>: (Задайте количество строк <1>:) -  при этом вы 

задаёте протяжённость массива вдоль оси Y;
• Enter the number of columns (|||) <1>: Задайте количество столбцов -  протяжён­

ность массива вдоль оси X;
• Enter the number of levels (...) <1>: Задайте количество уровней -  протяжённость 

массива вдоль оси Z;
• Specify the distance between rows (—): Задайте расстояние между строками;
• Specify the distance between columns (|||): Задайте расстояние между столбцами;
• Specify the distance between levels (...): Задайте расстояние между уровнями.
• 3D Mirror позволяет осуществлять зеркальное копирование трёхмерного объекта 

относительно указанной плоскости симметрии. Выполните Modify -» 3D Operation -* 
3D Mirror.

• Select objects: Выберите объект;
• Specify first point of mirror plane (3 points) or [Object/Last/Zaxis/View/XY/YZ/ZX/3points] 

<3points>: Укажите первую точку зеркальной плоскости -  можно ввести координаты, 
а можно указать с помощью привязки;

• Specify second point on mirror plane: Укажите вторую точку;
• Specify third point on mirror plane: Укажите третью точку;
• Delete source objects? [Yes/No] <N>: Удалить исходные объекты? [Да/Нет];
• 3D Rotate позволяет осуществить поворот трёхмерного объекта вокруг оси на 

некоторый угол. Выполните Modify -* 3D Operation -» 3D Rotate.
• Select objects: Выберите объект;
• Specify first point on axis or define axis by [Object/ Last/View/Xaxis/Yaxis/Zaxis/2points]: 

Укажите первую точку оси;
• Specify second point on axis: Укажите вторую точку оси;
• Specify rotation angle or [Reference]: Укажите угол поворота.
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• Align позволяет «собирать» сложные трёхмерные конструкции из элементов, 
выравнивая их по отношению к друг другу. Выравнивание можно осуществлять по 
одной точке, по двум и по трем точкам. Выполните Modify -* 3D Operation -*■ Align.

• Select objects: -  выбирается объект, который должен быть перемещён;
• Specify first source point: Задайте первую исходную точку -  точка на переме­

щаемом объекте (точка 1 на рисунке);
• Specify first destination point: Задайте расположение первой точки -  точка на ба­

зовом объекте, в которую будет перемещена первая точка (точка 2 на рисунке);
• Specify second source point: Задайте вторую исходную точку (точка 3 на рисунке);
• Specify second destination point: Задайте расположение второй точки (точка 4 на 

рисунке);
• Specify third source point or <continue>: Задайте третью исходную точку или 

<продолжить> (точка 5 на рисунке);
• Specify third destination point: Задайте расположение третьей точки:

Рисунок
Из 2М-команд редактирования, применимых к телам, стоит отметить снятие 

фасок и сопряжение граней.
• Chamfer !  . Выполните Modify -» Chamfer.
• Select first line or [Polyline/Distance/Angle/ Trim/Method/mUltiple]: Выберите пер­

вую линию -  укажите ребро той грани, с которой надо снять фаску.
• Enter surface selection option [Next/OK (current)] <OK>: Выбор грани [Следую- 

щаяЯекущая] <Текущая> -  если при указании ребра выделилась не та грань, кото­
рая нужна, выберите команду Next, а затем ОК (рис. 2.10).

• Specify base surface chamfer distance <1.0000>: Задайте первую длину фаски
• Specify other surface chamfer distance <1.0000>: Задайте вторую длину фаски
• Select an edge or [Loop]: -  выделяйте рёбра, вдоль которых надо снять фаску, 

завершите выбор клавишей Enter.
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• Fillet! J. Выполните Modify — Fillet.
• Select first object or [ Polyline / Radius / Trim/ multiple]: Выберите первый объект -  

выбирается любое ребро, вдоль которого необходимо выполнить сопряжение.
• Enter fillet radius: Введите радиус сопряжения
• Select an edge or [Chain/Radius]: Выберите ребро -  можно выбирать несколько 

рёбер, завершается выбор клавишей Enter.
Кратко перечислим некоторые команды панели Solids Editing, продемонстриро­

вав их применение (рис. 7.4 -  7.15) на примере следующего тела (применять преоб­
разования будем к выделенным на рисунке плоской грани и грани-отверстию):

Рисунок 7.4
• Extrude Faces CPfj -  Выдавить грань

Рисунок 7.5
*£* I• Move Faces MJ- Переместить грань 

перемещена плоская грань:

перемещена грань-отверстие:
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• Offset Faces S i -  Эквидистантное смещение грани 
смещена плоская грань:

Рисунок
положительное смещение отверстия:

Рисунок 7.9
отрицательное смещение отверстия:

Рисунок 7.10
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• Rotate Faces ш J -  Поворот грани
плоская грань повёрнута относительно своего нижнего ребра на положительный 

угол:

Рисунок
плоская грань повёрнута относительно своего нижнего ребра на отрицательный 

угол:

Рисунок 7.13

•  Copy Faces - Копировать грань (грань копируется как поверхность):

Рисунок 7.14

• Shell ®  -  Создание оболочки. При выборе команды сначала надо выбрать те­
ло (здесь не допускается множественный выбор); затем можно указать грани, кото­
рые исключатся из оболочки (в оболочке, изображённой на рисунке, исключена 
грань, выделенная штриховкой); после выбора граней указывается толщина оболоч­
ки и завершается работа с командой двойным нажатием клавиши Enter.
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При выборе исключаемых или добавляемых граней следует придерживаться сле­
дующих правил:

• выбор в контекстном меню параметра Remove даёт возможность указать ис­
ключаемые грани;

• выбор в контекстном меню параметра Add даёт возможность добавить исклю­
ченные грани;

• выбор добавляемой/удаляемой грани производится щелчком по её плоскости 
(если грань видна);

• щелчок по ребру позволяет выбрать сразу две грани, примыкающие к этому 
ребру;

• если по ошибке или преднамеренно была удалена грань, которую исключать не
требуется, используют параметр Add.

!
• Color Faces j£zJ -  Цвет грани.
• Color Edges I zj -  Цвет ребра.

8. Визуализация трёхмерных объектов
Создание реалистичных трёхмерных изображений помогает лучше представить 

окончательный вид разработанной детали. Изображения с удаленными скрытыми 
линиями выглядят более реалистично, наиболее же наглядными являются раскра­
шенные и тонированные модели.

Самый простой вид изображений -  это изображения с удаленными скрытыми 
линиями. В процессе раскрашивания каждой поверхности тела присваивается не­
который цвет. При тонировании поверхностям присваиваются различные материа­
лы со всеми присущими им оптическими свойствами и задается освещение объекта.

Удаление скрытых линий. В процессе рисования и редактирования работа ве­
дется с каркасным представлением объектов и поверхностей, удаление скрытых ли­
ний на промежуточных этапах используется для проверки правильности расположе­
ния поверхностей. Удалить скрытые линии можно одной из команд View -» Hide или 
View-» Shade-» Hidden:

Для быстрого доступа к команде Hide имеется соответствующая кнопка ’5,г в па­
нели Render.

Раскрашивание (затенение). Хотя удаление скрытых линий улучшает восприятие 
рисунка, более реалистичного изображения модели можно достичь путем её рас­
крашивания. При раскрашивании рисунка AutoCAD автоматически производит уда­
ление скрытых линий. Подразумевается, что источник света один и расположен за 
спиной пользователя (так называемый "свет из-за плеча").
16



Раскрашивание производится одним из четырех методов (рис. 8.2 -  8.4):
• View -» Shade -* Flat Shaded -  подходит для тел с плоскими гранями. Если 

раскрасить этим методом тело со скруглёнными гранями, они будут выглядеть «гра­
нёными»:

Рисунок

• View -* Shade -> Gouraud Shaded -  можно применять как для плоских, так и 
для скруглённых поверхностей:

Рисунок 8.3

• View -» Shade -*■ Flat Shaded, Edges On -  комбинация плоского затенения с 
каркасным представлением модели.

• View -* Shade -*• Gouraud Shaded, Edges On -  комбинация сглаженного зате­
нения с каркасным представлением модели:

Рисунок 8.4

Тонирование. Тонированные изображения выглядят гораздо более реалистично, 
чем изображения с удалёнными скрытыми линиями или раскрашенные.

В результате тонирования получаются высококачественные изображения, срав­
нимые с рисунками, полученными традиционными способами: акварелью, цветными 
карандашами, тушью.

При тонировании используется меню Viev-* Render или панель Render (рис. 8.5):

Рисунок 8.5
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В проектах с использованием трёхмерного моделирования процесс тонирования 
является отдельной серьёзной задачей, на которую зачастую тратится большая часть 
компьютерного времени. Этот процесс обычно происходит в несколько этапов:

8.1. Подготовка моделей -  поверхностных или твердотельных.
• Рекомендуется применять однотипные методы построений. Не следует строить, 

например, модели зданий, одни стены которых представляют собой грани, другие -  
выдавленные отрезки, а третьи -  каркасные сети.

• При описании поверхностей нужно стремиться к минимизации числа граней. 
Чем проще структура поверхности, тем меньше времени тратится на определение 
цвета каждой точки грани.

8.2. Работа с цветом или материалами.
• Для присвоения модели материала выполните View -» Render-> Materials... .
• В окне Materials (рис. 8.6):

Materials:
si щ  * *J

Modify... j

OK Cancel Help

Рисунок 8.6
• Кнопкой Materials Library... вызывается окно Materials Library, в котором вы­

бранный в правом списке материал можно просмотреть и импортировать в чертёж 
(при этом он отобразится в списке Current Drawing). Вы можете загрузить в чертёж 
сразу несколько материалов. Для возврата в окно Materials нажмите кнопку ОК:

Materials Library Э В Е  2*мг х]
Current Drawing

"GLOBAL* 
BLUE RINGS

Purge Save As...

, f " 4

Preview

Sphere

<-Import

Delete

Current Library

I render ~3
BLUE GOOSE 
BLUE MARBLE 
BLUE MATTE 
BLUE METALIC 
BLUE PLA.NET 
BLUE PLASTIC 
BLUE PLASTIC 27 
BLUE PLASTIC 50 
BLUE PLASTIC 77

BLUE/GREEN/CYAN T 

Open... j Save [

Save As...

OK Cancel Help

Рисунок 8.7

• В окне Materials загруженные материалы отображаются в списке Materials (рис. 8.8).

18



• Нажатие кнопки Attach< временно закрывает окно Materials для того, чтобы 
можно было выбрать те объекты, которым требуется присоединить выбранный ма­
териал. Завершается выбор нажатием правой кнопки мыши в области чертежа или 
клавишей Enter.

• Кнопка Detach< позволяет удалить материал с выбранного объекта.
• Кнопка By ACI... позволяет присвоить материал всем объектам, для которых ус­

тановлен определённый цвет.
• Кнопка By Layer... связывает материал со слоем.
• Кнопка Duplicate создаёт копию выделенного материала.
• Кнопка Modify открывает окно редактирования материала.

Рисунок 8.8
8.3. Собственно тонирование -  этот этап обычно состоит из нескольких опера­

ций тонирования, повторяющихся до тех пор, пока не будет достигнут нужный ре­
зультат, с соответствующей подстройкой характеристик после получения каждого 
промежуточного результата.

Для выполнения тонирования выполните View -* Render -> Render i f . .  В окне 
Render нажмите кнопку Render -  будет произведено тонирование (рис. 8.9) с уста­
новками по умолчанию.

Рисунок 8.9
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9. Видовые экраны
AutoCAD предлагает два типа видовых экранов -  непересекающиеся (tiled) и пе­

рекрывающиеся или плавающие (floating).
Основное назначение неперекрывающихся видовых экранов -  облегчить форми­

рование чертежа. Сколько бы видовых экранов вы ни создали, они все будут ото­
бражаться в графической зоне и занимать полностью её площадь.

В отличие от неперекрывающихся плавающие видовые экраны являются само­
стоятельными объектами, они предназначены для организации вывода чертежа на 
бумагу. Плавающие видовые экраны образуют раскладку в пространстве листа, что 
позволяет рассматривать экран как лист бумаги. Плавающие видовые экраны могут 
располагаться на экране в произвольном порядке, их можно перемещать, скрывать. 
Для них можно настроить отображение слоёв так, чтобы, например, слой, отобра­
жающийся на одном видовом экране, не отображался на другом.

Неперекрывающиеся видовые экраны. Для создания неперекрывающихся ви­
довых кранов выполните View -» Viewports -* New Viewports... В окне Viewports под­
берите подходящую конфигурацию экранов -  это легко сделать, просматривая 
предложенные варианты в окне Preview. Если вы планируете в дальнейшем рабо­
тать с несколькими самостоятельно настроенными конфигурациями видовых экра­
нов, задайте имя в поле New name (рис. 9.1):

New Viewports j Named Viewports 

New name:

Standard viewports:

myViewPorts

“Active Model Configuration1' 
Single
Two: Vertical 
Two: Horizontal

Three: Left 
Three: Above 
Three: Below 
Three: Vertical 
Three: Horizontal 
Four: Equal 
Four: Right 
Four: Left

Apply to:

Display

Setup:

-P rev iew

3  L® 3

Change view to: 

| “Front" z l

OK Cancel Help

Рисунок 9.1
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Теперь экран разделён на выбранное вами количество областей, в каждой можно 
установить произвольный вид обычным способом (рис. 9 2):

Рисунок 9.2
При необходимости можно любой видовой экран разбить ещё на несколько экра­

нов. Для этого выделите его, откройте окно Viewports, выберите конфигурацию и в 
списке Apply to выберите Current Viewport (рис. 9.3):

Команда View -> Viewports -> Join позволяет объединить несколько видовых экра­
нов в один.

Плавающие видовые экраны. Для создания плавающих видовых экранов можно 
воспользоваться той же командой, которой создаются неперекрывающиеся видовые 
экраны, только сделать это нужно на одной из вкладок компоновки (Layout). По 
умолчанию имеются две вкладки Layoutl и Layout2, но при желании можно создать 
до 256 вкладок. При переключении на вкладку компоновки первый раз открывается 
окно Page Setup, в котором настраиваются параметры печати. В данный момент 
достаточно только выбрать принтер -  тогда на листе будет доступен предваритель­
ный просмотр чертежа. После этого открывается выбранная вкладка компоновки с 
созданным на ней одним плавающим видовым экраном.
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Кроме этого, AutoCAD автоматически переключается в пространство листа, о чём 
можно судить по крайней правой кнопке в строке состояния -  на ней сейчас написа­
но PAPER. Щелчком по этой кнопке можно переключаться между пространством мо­
дели (model space) и пространством листа (paper space).

Термин «пространство модели» обозначает основной режим вычерчивания и ре­
дактирования чертежа. В пространстве модели можно работать в каждом видовом 
экране отдельно, при этом все изменения будут отражаться на всех экранах и на 
всех вкладках.

В пространстве листа чертить можно непосредственно на листе, доступа к модели 
(детали) нет. В пространстве листа можно перемещать видовые экраны, изменять их 
размеры, переносить их из слоя в слой (чтобы получить возможность отключать их 
видимость). Кроме этого, можно начертить рамку и основную надпись, таблицы спе­
цификаций, подписи к видам. При этом на других вкладках эти элементы чертежа 
отображаться не будут.

Для создания плавающих видовых экранов перейдите на вкладку компоновки и 
выполните View -* Viewports -*• New Viewports..., выберите нужную конфигурацию. 
После нажатия кнопки ОК в командной строке будет выведен запрос Specify first 
corner or [Fit] <Fit> (Укажите первый угол или [Вписать]). Укажите рамкой прямо­
угольник, в который будет вписана выбранная конфигурация видовых экранов. Если 
выбранная конфигурация должна занимать весь лист, выберите команду Fit. После 
создания видовых экранов их можно редактировать обычными средствами (рис. 9.4):
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10. Выполнение работы
10.1. Строим трехмерную модель детали.
10.2. Переходим из пространства модели в пространство листа (Layoutl).
10.3. Настраиваем параметры листа (рис. 10.1) для печати. (File^-Page Setup 

Manager-» Modify).

fa 9 Page Setup Manager

Щmm Current layout: Layoutl
® LeEZimoulM 

pase.Se tug,onager

Page setups

Current page setup: <None>

Selected page setup details 

Device name: Microsoft XPS Document W riter

Plotter: Microsoft XPS Document W riter

Plot size: 297.01 x 419.99 mm (Landscape)

Where: XPSPort:

Description:

S 3 Display when creating a new layout dose Help

Рисунок
10.4. Устанавливаем принтер (при необходимости 

масштаб (рис. 10.2).

Page Setup 

Page setup

Name: <None>

Printer/plotter

Name: Microsoft APS Documertf Wnter Properties

Plotter:

Where: XPSPort:

Description:

Paper size

Microsoft XPS Document Writer - Windows System ... _  ̂ £g7 NN |^_

IT 
§

Plot area 

What to plot:

|Layout t j

Plot offset {origin set to printable area)

X; 0*^0 mm О  Center thepfct

Plot scale

L jF it to paper

Scale: 1:1

1
i  unit

О  Scale lineweights

виртуальный), формат листа,

Pbt style table (pen assignments)

i monochrome.ctb si
О  Duplay plot styles 

Shaded viewport options

As displayedShadeЫ 

Quality I Normal

DPI i 300

Plot options

[  ц  Plot object Inewelghis 

Щ \Plot with plot styles 

№  Plot paperspace last 

П  Hide paperspace objects

Drawing orientation 

О  Portrait 

ф  Landscape 

L.j Plot upside-down

OK

Рисунок 10.2
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10.5. Копируем в пространство листа предварительно выполненную рамку с ос­
новной надписью (рис. 10.3).

Рисунок

10.6. Отключаем границы печатаемой области. Для этого вызываем в меню 
Tools-* Options и отключаем Display printable area и Display paper backgraund
(рис. 10.4).

■ O p tions -'«*ттттт*. ш Ш

Current profile: Ntisl Setup Profile *§ t Current drawing: Проба-разрезы.dwg

files Display Open and Save I Plot and Publish j System | User Preferences j Drafting j 3D Modeling | Selection j Profiles,

Window Elements Dismay resolution

Color scheme j Light ■w I 40C be and d rd e  smoothness

Ш Display scroll bars in drawing window 

О  Display Drawing status bar 

ЁЗ Display screen menu 

О  Use large buttons for Toolbars 

§8 Show ToolTips

[Vj Show shortcut keys in ToolTips 

Щ Show extended ToolTips

2 Number d seconds to delay 

SO Show rolover ToolTips

’ 3^ 3 Segments in a polyline curve 

mIj 0.5 Rendered object smoothness 

Ж1 2 Contour lines per surface

Display performance

О  Pan and zoom v&h raster 4 OLE  

[V] Highlight raster image frame only 

f§. [ l im p ly  so ldfii

Id  Show text boundary frame only

Id  Draw true silhouettes for sofids and surfacesj Colors... I j Fonts... j

Layout elements

Ш Display Layout and Model tabs 

0  Display printable are a 

О  Display paper background

Crosshair size

5 o .....-
Fade control 

>ref display

LJ Display paper shadow'
О  Snow Page Setup Manager for new layouts 

Щ Create viewport in new layouts

70 U M l
In-place edit arid annotaiive representations

50 ........................[J

[_ OK j j. Cancel j [ О Д  }\ Help ] f

Рисунок 10.4
10.7. Создадим первый из стандартных видов -  вид сверху. Для этого служит ко­

манда View панели Modeling: Modeling -» Setup -> View (рис. 10.5).
Команда позволяет создавать стандартные виды разными способами. Сейчас нам 

нужен вариант UCS, в котором вид создается на базе системы координат модели. 
Выбираем UCS, которая будет являться основой для вида, в данном случае -  миро­
вую, т.е. World.
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На запрос масштаба вида соглашаемся с предложенной единицей, т.е. 1:1, затем 
команда попросит указать центр будущего вида, причем его можно указывать не­
сколько раз, чтобы подобрать наилучший вариант. Когда такой вариант выбран, на­
жимаем Enter и по запросу команды указываем границы видового экрана.

Наконец, команда запрашивает имя экрана -  вводим «вид сверху», Enter.

Command: _solview
Enter an option [Ucs/Ortho/Auxiliary/Section]: u 
Enter an option [Named/Worid/ ?/CurrentJ <Current>: w 
Enter view scale <1>:
Specify view center:
Specify view center <specify viewports-:
Specify first corner of viewport:
Specify opposite corner of viewport:
Enter view name: вид сверху

Рисунок
Далее необходимо переключиться к каркасному отображению. Для этого делаем 

двойной клик внутри вида и переходим к отображению 2D Wireframe (панель View).
Чтобы выйти из видового экрана в лист, делаем двойной клик на чистом про­

странстве листа. В итоге получаем первый стандартный вид (рис. 10.6):

Рисунок 10.6
Если при масштабе 1:1 изображение детали слишком мало или слишком велико, 

масштаб можно скорректировать. Выделите видовой экран и, используя команду 
Properties, задайте Standart scale 1:1. (в некоторых случаях может понадобиться 
нестандартный масштаб -  он задается в поле Custom Scale).

10.8. Создаем аналогично следующий вид -  вид спереди. Теперь вместо опции 
UCS выбираем опцию Ortho -  она строит ортогональные виды на базе уже созданных 
экранов. После этого команда запросит сторону проекции. Фронтальный вид получа­
ется из вида сверху при проецировании «снизу вверх» (по чертежу). Поэтому указы­
ваем нижнюю сторону вида сверху (рис. 10.7):
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Рисунок
Затем указываем центр будущего вида, его границы и задаем имя. В итоге мы по­

лучаем на чертеже второй вид -  вид спереди (рис. 10.8).

Рисунок 10.8
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Аналогично строим третий вид -  вид слева (рис. 10.9).

Рисунок
Полученные виды можно перемещать, при этом сохраняется проекционная связь 

между изображениями.
10.9. Выполним необходимые простые разрезы. Для этого в команде Modeling -* 

Setup -*• View выбираем опцию Section. Указываем первую и вторую точки линии 
разреза на виде сверху, используя объектные привязки. Затем указываем центр ви­
да, границы и задаем имя «фронтальный разрез» (рис. 10.10).

Рисунок 10.10
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В результате образуется еще один видовой экран (10.11).
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Рисунок 10.11
Аналогично строим видовой экран, соответствующий профильному разрезу. Все 

видовые экраны можно произвольно перемещать и поворачивать (рис. 10.12).
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10.10. Далее обратимся к окну Layer Properties Manager (рис. 10.13):

✓ VPORTS Is й of ■ w... Ccntinu.., ------  Defa... CelorJ? © F,
£7 вид сверху-DIM I я й of ■ w... Ccntinu... ------  Defa... Cc4orJ © 4
£7 вид сверху-HID \ я Й of ■ w... HIDDEN ------  Defa... CoicrJ © %

вид с верху-VIS \я й of ■ w... Ccntinu,.. ------  Defa... Color..? © %
вид слева-DIM я Й of ■ w... Ccntinu,.. ------  Defa.,. Color 7 © q3

/7 вид спевз-НГО я Й of ■ w... HIDDEN ------  Defa... Colcr_7 © 4
£7 вид слева-VIS я й rif ■ w... Ccntinu... ------  Defa... Color? ©
£7 вид спереди-DIM я Й ctf 1 w... Continu... ------  Defa... Color..? © n

вид спереди-HID я Й ■ w... HIDDEN ------  Defa.,. Color.? R
9 вид спереди-VIS шшшшшIf Ц

Рисунок 10.13

Слои с невидимыми линиями обозначены «НЮ», с видимыми -  «VIS», а со штри­
ховкой -  «НАТ». Символы до дефиса -  имя видового экрана, при создании которого 
появился слой. Задаем для этих слоёв различный тип и толщину линий (рис. 10.14).
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Рисунок 10.14

10.11. Преобразуем видовые экраны в чертежи. Для этого используем команду 
Modeling -* Setup -* Draw. На запрос команды указываем все видовые экраны. Ко­
манда автоматически скроет модель в каждом из них, а вместо этого появятся види­
мые линии и штриховка, расположенные в соответствующих слоях (рис. 10.15).



10.12. Добавляем еще один видовой экран -  аксонометрическое изображение де­
тали (рис. 10.16).
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Рисунок 10.16

Зайдя в пространство модели чертежа, при необходимости командой Slice вы­
полняем вырез четверти в пространственной модели.

10.13. Дорабатываем чертеж, работая в каждом видовом экране. Выполняем раз­
резы, проставляем размеры.

Включаем границы печатаемой области: Tools-» Options и включаем Display prin­
table area и Display paper backgraund (рис. 10.17).
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Рисунок 10.17

30



а Ф
и 

р
10.14. На последнем этапе в окне Layer Properties Manager отключаем види­

мость слоя VPORTS, который отображает рамки видовых экранов (рис. 10.18).

Рисунок 10.18
10.15. Печатаем чертеж из пространства листа.
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